
KeyStone Learning Systems Multimedia

KeyStone Learning Systems’ Multimedia Training

Table of Contents

MINIMUM SYSTEM REQUIREMENTS........................................................................................................................................2

TECHNICAL SUPPORT..............................................................................................................................................................2
KNOWN INSTALL CONFLICTS..................................................................................................................................................2

1.0 GETTING STARTED.........................................................................................................................................................3

1.1 INSTALLING THE APPLICATION........................................................................................................................................3
1.2 LAUNCHING THE APPLICATION........................................................................................................................................5
1.3 THE ENVIRONMENT......................................................................................................................................................... 6

2.0 USING THE BASIC FEATURES OF THE APPLICATION....................................................................................... 12

2.1 SPECIFYING A PATH TO LESSON FOLDERS....................................................................................................................12
2.2 VIEWING A LESSON....................................................................................................................................................... 13
2.3 VIEWING MULTIPLE LESSONS.......................................................................................................................................14
2.4 REVIEWING LESSONS.....................................................................................................................................................15
2.5 RIGHT MOUSE BUTTON................................................................................................................................................. 16
2.6 MICROSOFT ACTIVEMOVIE PLAYER FEATURES............................................................................................................16
2.7 LOTUS SCREENCAM PLAYER FEATURES....................................................................................................................... 17

3.0 USING THE QUIZ FEATURE.........................................................................................................................................19

3.1 TAKING A QUIZ..............................................................................................................................................................19
3.2 REVIEWING QUIZ SCORES.............................................................................................................................................20

4.0 VIEWING KEYNOTES.................................................................................................................................................... 23

5.0 KEYWORD SEARCHING............................................................................................................................................... 25

6.0 SYSTEM ADMINISTRATION........................................................................................................................................ 28

6.1 SETTING UP THE TRAINING FOR MULTIPLE USERS.......................................................................................................28
6.2 ADDING USERS.............................................................................................................................................................. 28
6.3 DELETING USERS...........................................................................................................................................................30
6.4 RESETTING USER QUIZ SCORES....................................................................................................................................30
6.5 UN-INSTALLING THE PROGRAM.....................................................................................................................................31

 Copyright 1999 KeyStone Learning Systems Corporation. 1



KeyStone Learning Systems Multimedia

Minimum System Requirements

1. Windows 95 or Windows NT 4.x

2. Pentium 133mhz processor

3. 16mb of RAM

4. 8x CD-ROM drive

5. Video or Graphics Accelerator card

6. Audio card with speakers or headphones

7. 1mb hard disk space

Technical Support
For technical support questions, please call:

1-800-801-0952

Known Install Conflicts
After the install you may see a “File Association” message like this:

You can simply close this window by clicking “OK” without any adverse effects to your system. 

Another message that you may encounter during installation looks like this:

You will see this message only if your version of ActiveMovie is newer than the version the setup is trying to install. Simply 
click “OK”, with no adverse effect to your system.
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1.0 GETTING STARTED

1.1 Installing the Application
1. Shut down all applications except Windows.
2. Place the disk in your CD-ROM drive.
3. Click on the “Start” button.

4. Highlight “Run”.

5. Type the letter designation of your CD-ROM drive followed by a colon, a back slash, and the word “setup”.  If your CD 
drive is “D” you would type “D:\setup” and click “OK”.

6. From the “Welcome” dialog box, click “Next”. If at any time you wish to stop the install, click “Cancel”.

7. Enter the appropriate information in the “User Information” dialog box and click “Next”. You must complete both the 
“Name” and “Company” fields in order for the install to continue.
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8. The “Choose Destination Location” dialog box displays the destination location for the program’s files. This location is 
on your hard drive (default is the C drive). You can choose a different location by clicking “Browse” and selecting a new 
destination, and clicking “Next”. If the default location is okay, click “Next”. 

9. When you click “Next” the “Select Program Folder” dialog box appears. The setup creates a “KeyStone Learning 
Systems” folder for the program icon. If you have additional KeyStone Multimedia Training CD’s, the setup places their 
program icons into this folder. To accept the setup’s location, click “Next”. To change the location, highlight another 
folder and click “Next”.

10. The “Start Copying Files” dialog box displays information about the setup. If you wish to modify anything, click “Back” 
and make the changes. If the information is correct, click “Next” to start the copying process.
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11. When the copying process is finished you are asked to restart your computer. If you choose not to restart your computer 
select the “No...” radio button and click “Finish”, otherwise just click “Finish”. 

Your computer restarts and you are returned to the Windows desktop where you can start the application.
12. If you chose not to restart your computer an additional dialog box appears. It is recommended that if you wish to use the 

KeyStone Multimedia program you should select the "Restart..." option.

1.2 Launching the Application
1. Click on the “Start” button in Windows.

2. Highlight “Programs”, then “KeyStone Learning Systems”, and then the name of the course.
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1.3 The Environment
The KeyStone Multimedia Training interface is divided into four areas:

Menu Bar
The menu bar is the gray horizontal bar below the application title bar. It has four menu options: File, Action, Administration, 
and Help.

File Menu

Click on “File” and you see “Options” and “Exit”.

“Options” lets you do two things: (1) Specify the path to the video and text lesson files and (2) keep the video lesson window on 
top. “Specifying Path to Lesson Folders” is a very important setting; one you may need to change before using this application. 
We will discuss this in more detail in 3.1 Specifying a Path to Lesson Folders . “Video Window Always On Top” lets you keep 
the video lesson window (player) on top of other applications you may have opened. So anytime you switch over to another 
application the video window continues playing on top of that application. This feature is helpful if you are following along with 
the training. For a description on how to view lessons, refer to 2.2 Viewing a Lesson and 2.3 Viewing Multiple Lessons. For a 
description of the different video windows and their features, refer to 2.6 Microsoft ActiveMovie Player Features or 2.7 Lotus 
ScreenCam Player Features  .   
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The “Exit” option lets you quit completely out of the program.

Action Menu

The “Action” menu has six options. Depending upon what is selected in the Course Outline, some choices may be grayed out or 
disabled. Each of these choices functions the same as the buttons with the corresponding names. Each button's feature is 
discussed in more detail later in this section under the heading “Button Bar”.

“View Lessons” lets you view the lesson files for the selected section or sub-section.
“View KeyNotes” lets you view the particular text files that are associated with the selected section or sub-section. 
“Take Quiz” allows you take a quiz for a particular section or sub-section. KeyStone’s Multimedia Training also keeps track 

of which quizzes have been taken and the scores for each.
“Review Quiz Scores” gives you results of each quiz you have taken.
“Review Lessons” is similar to “View Lessons” in that it lets you to view the lessons for a selected section or sub-section. 

The only difference is that “Review Lessons” allows you to choose which lesson file to view if multiple files exist.
“View all Lessons” lets you view all the lessons found in a selected section or sub-section. This feature is only available 

when additional sub-sections exist in a section or sub-section. Additional sub-sections are indicated by a plus sign. 

Administration Menu

The first time you run this application you see the following three menu options under “Administration”:

As the menu implies, these options help the system administrator set up the application for multiple use. For step-by-step 
instructions on how to set up this application for multiple users and how to create those users, refer to 6.0 System 
Administration. Let’s take a look at each option:

 “Multiple Users” is simply a toggle. When checked every user will need a login and password and only the administrator 
can see every user’s quiz score. When it’s unchecked the program launches without asking for a login and  password. 
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“Change Password” allows you to change your user login password. When this option is selected, the “Change Password” 
dialog box appears and you are asked to enter in your old password and then the new password. When you are done, click 
“OK”.

“Maintain Users” allows you to add, delete, and change user logins and passwords as well as login and password for the 
administrator. It also lets the administrator reset quiz scores. “Maintain Users” is also discussed in more detail in 6.0 
System Administration. When this option is selected the “Maintain Users” dialog box appears:

When this application is setup for multiple users (“Multiple Users” checked), each user will be required to enter a login and 
password. Then when “Administration” is clicked, only the “Change Password” option is available.

Help Menu

The Help menu provides three options: “Keyword Search”, “Meet the Instructor”, and “About”.

 “Keyword Search” allows you to search all the lessons for specific topics based on keywords you enter. As you type in the 
first few characters, the system immediately goes out and locates the closest match. For step-by-step instructions on how 
to use the keyword feature, refer to 5.0 Keyword Searching.
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“Meet the Instructor” displays biographical information about the instructor. Click “OK” to close this feature.

The “About” option displays contact information for KeyStone Learning Systems. Included are the mailing address, phone 
and fax numbers, and the URL to KeyStone’s website. Click “OK” to close.
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Course Title
When you start the application you see the course title and level in the red bar just below the menu bar. 

Course Outline
The Course Outline is exactly that, it is an outline of all the topics contained in the course, broken down by sections and sub-
sections. To select a section, simply click on the bullet or the text to the right of the bullet.

Note that some sections contain additional topics or sub-sections. Sections that contain sub-sections are indicated by a white plus 
sign. To expand this section, double-click the plus sign. The plus sign is now replaced by a minus sign. To collapse the section, 
double-click on the minus sign. Now the minus changes back to a plus.

Button Bar
Below the Course Outline is a set of different colored buttons. Depending upon what you have selected on the course outline, 
you see different buttons available. These buttons have the same functions as the options found under the “Action” menu. 

The “View Lesson” button plays a video lesson for the selected section or subsection.

The “KeyNotes” button lets you view a list of text notes and exercises pertaining to the section or sub-section.

 The “Take Quiz” button lets you take a quiz about the section you have selected.
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 The “Review Quiz Scores” button lets you see which lessons you have viewed and how you scored on each quiz. Any 
section you haven’t viewed has a gold star by it and the quiz score displays a “0”.

 The “Review Lessons” button lets you view lessons assigned to a section or sub-section.

The “View All Lessons” button plays every video lesson sequentially for a selected section.
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2.0 USING THE BASIC FEATURES OF THE APPLICATION

2.1 Specifying a Path to Lesson Folders
Before you actually use your KeyStone Multimedia Training application, you first need to tell your computer where to find the 
all-important lesson files. If you do not specify the correct location you will get the “Locate Lesson Files” dialog box when you 
try to view a lesson:

If you do receive this dialog box, click on “Browse”, and locate the correct location of the file specified in the “File” field. The 
lesson files are located in various folders on the CD from which you just installed this program. Your specific training CD may 
or may not contain the same files and folders as the example below, but generally they appear in the following:

The “CD Instructions” folder contains the instruction file you are viewing right now. It is in both the ".doc" and ".txt" 
format.

The “KeyNotes” folder contains all the supplemental documentation that accompanies the training. KeyNotes are text 
documents that either go hand-and-hand with the video or can be used as stand-alone training. These files are Microsoft 
Word documents (“.doc” files accessed by Microsoft Word or by your word processing application).

The “Sample Files” folder contains all the files necessary to complete the exercises or examples for the training. 
The “Scm” and “Video” folders contain the audio/visual files that make up the largest portion of the training. These files are 

accessed by clicking on the “View All Lessons” or “View Lesson” buttons or from the “Action” menu.
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The “Text” folder contains the text files (“.rtf”) for each section of the training. These files are accessed from the keyword 
searching feature (available from the “Help” menu) and by clicking the “KeyNote” button (which accesses the KeyNote 
Viewer).

To specify the path, do the following:

1. Click on the “File” menu, highlight “Options”, and select “Specify Path to Lesson Folders…”. 

2. From the “Specify Path…” dialog box, enter the path to the folders that contain the lesson files and click “OK”. If this is 
an initial install you should specify your CD-ROM drive (example below). If you have moved these lesson files on to your 
hard drive or a network then specify that path and click “OK”.

2.2 Viewing a Lesson
(If you are a single user, leave the “Multiple Users” option unchecked in the “Administration” menu)

To view a single topic do the following:

1. Click on a section title in the Course Outline or double-click on the plus sign to expand selection and select a sub-topic.
2. Click on “View Lessons”, or select “View Lessons” from the “Action” menu, or press <Ctrl><L> on the keyboard. 
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3. A Microsoft ActiveMovie or Lotus ScreenCam  player appears, and the first lesson file runs. To stop the playback, click 
on “Stop”. To pause a lesson, click on the Pause/Play button. This button toggles between pause and play. Also the 
<Space Bar> functions the same as the Pause/Play button. To close the lesson, click on the “Close” button in the upper 
right corner of the window or panel. We will describe the features of these viewers a little later in this section.

4. When the first lesson file is done the next runs, through the whole sub-section, unless you click on the “Close” button (X) 
in the upper right of the video window. 

As you view these video files, you will often see a dialog box like this:

This dialog box is specific to the Lotus ScreenCam files (“.scm”) and only appears when it is loading the next file. Sometimes 
this box appears and disappears very quickly, leaving you with little or no time to read the options.  You basically have two 
options: (1) Let the next file load and play or (2) cancel the remaining lessons by clicking the “Cancel…” button.  You also have 
a third option that cannot be accessed from this dialog box. This option is performed by clicking on the “Closed” box in the 
upper right corner of the ScreenCam control panel. For a description of the ScreenCam player and its features, refer to 2.7 Lotus 
ScreenCam Player Features.

2.3 Viewing Multiple Lessons
For those viewers who want to see the entire lesson files contained in a section, do the following:

1. Select a section from the Course Outline.
2. Click on the “View All Lessons” button, or select “View All Lessons” from the “Actions” menu, or press <Ctrl><A> on 

the keyboard.
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“View All Lessons” plays all the lesson files for the selected section. To stop any of the lessons, click on either the “Stop” 
button or the “X” in the upper right corner of video window or control panel.

2.4 Reviewing Lessons
The “Review Lessons” feature lets you see all or selected lesson files assigned to a particular section or sub-section. For 
example, sub-section 2.2 has six lesson files assigned to it. If you were to click on “View Lessons” with 2.2 selected, you would 
view all six files, starting with the first. But if you clicked on “Review Lessons”, you have the option to select only the files you 
wish to view. 

1. Select the sub-section you wish to view.
2. Click on the “Review Lessons” button, or select “Review Lessons” from the “Action” menu, or press <Ctrl><R>.

3. The “Lessons” dialog box appears. To view a lesson, highlight it and click “Select” or double click on the lesson name. 
Depending upon the type of lesson file you selected, you see either the Microsoft ActiveMovie or the Lotus ScreenCam 
Player. “Video” brings up the ActiveMovie player and “Demo” brings up the ScreenCam player.

To close the window click the “Close” button or the little “X” in the upper right corner.
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2.5 Right Mouse Button
You can also access the same features found under the “Action”  menu, on the “Button Bar”, or by clicking with the right mouse 
in the course outline. Simply select the section or sub-section and click with your right mouse button. You can view lessons, 
view all the lesson files, take a quiz, review quiz scores, etc.

2.6 Microsoft ActiveMovie Player Features
There are two types of video lesson files found in your CD-ROM training, Mpeg and ScreenCam. The Mpeg files have the 
extension “.mpg” (Mpeg format) and are viewed with the Microsoft ActiveMovie Player. The ActiveMovie Player has some 
features that you will need to know in order to view your training effectively. The following is an example of the ActiveMovie 
player window:
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To stop the playback of a lesson, click on the “Stop” button. 
You can also pause any open video by clicking the “Pause/Play” button or by pressing the <Space Bar> on your keyboard.
Click and drag the slider at the bottom of the screen to fast-forward or rewind the playback. 
Click the button with a dash in the upper right to minimize the video lesson window.
Click the middle button in the top right to maximize the video lesson window.
Click the “X” in the upper right to stop all video lessons and close the video window. 
To resize the window, place the cursor on any edge of the window. When the cursor changes to a double-headed arrow, click 

and drag to the desired size. 
To move the player window, click and drag on the blue title bar to the new location.

2.7 Lotus ScreenCam Player Features
The second type of video file is ScreenCam. This file is actually a screen capture using a product called Lotus ScreenCam.  It has 
the extension of  “.scm” and is viewed with the Lotus ScreenCam Player. You control the playback with the following 
ScreenCam control panel:

To stop the playback of a lesson, click on the “Stop” button (red square). 
To pause any opened ScreenCam file, click the “Pause/Play” button or press the <Space Bar> on your keyboard.
To fast forward, click on the “Fast Forward” button (double arrows). 
The only rewind feature available is the “Rewind to Beginning” which restarts the playback.
To view another ScreenCam file, click on the “Open File” button (open folder icon), select the file, and then click “Open”.
To adjust the volume level, click and drag the volume slider to the desired level. This control works independently from the 

Volume Control on the system tray.
To close the player, click on the “Close” button.
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The ScreenCam player also has the identical “Minimize” and “Maximize” buttons in the upper right corner as the 
ActiveMovie player window.

To move the control panel, click and drag on the blue title bar to the new location.
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3.0 USING THE QUIZ FEATURE

3.1 Taking a Quiz
The quiz feature of KeyStone’s Multimedia Training allows you to take a multiple-choice quiz for each section on the CD-ROM. 
This feature keeps track of the quizzes taken, the scores for each quiz, and what sections were viewed. If you are a system 
administrator, you can keep track of quiz scores and progress of multiple users. 

To take a quiz…

1. Select a main section heading. Click the “Take Quiz” button, or select “Take Quiz” from the “Action” menu, or press 
<Ctrl><Q> on the keyboard.

2. The Quiz dialog box appears. Read the question and select the correct answer.

If your selection is correct, a smiley face appears…
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If not, an “X” appears… 

3. To continue to the next question click “Next”. In the lower left corner you see the current score for the quiz you are 
taking. 

4. To stop and exit out of the quiz, click “Close” or click on the “Close” button (X) in the upper right corner of window.

5.  When you have answered all of the questions in the quiz the “Next” button becomes dimmed. 

Click “Close” when you complete each quiz.

3.2 Reviewing Quiz Scores
As was mentioned earlier, you can also keep track of what sections you have taken quizzes for and the score for those quizzes. 
This feature is accessed by clicking on the “Review Quiz Scores” button, or by selecting “Review Quiz Scores” from the 
“Action” menu, or by pressing <Ctrl><U> on the keyboard.

To review your quiz scores do the following:

1. Access the “Review Quiz Scores” feature.
 

2. The “Review Quiz Scores” dialog box appears. Note that each section whose lessons have NOT been viewed has a gold 
star by its icon (blue book). 
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3. Highlight the section and the score is displayed in the lower left corner of the window.

4. Any quiz that has not been taken displays the message “0 out of…”.

If you are a system administrator and wish to review your user’s quiz scores and progress, do the following: 

*Note that in order to have multiple users access the program the “Multiple Users” option must be checked. For more 
information about creating users and additional system administration topics, refer to 6.0 System Administration.

1. Click on the “Review Quiz Scores” button, or select “Review Quiz Scores” from the “Actions” menu, or press 
<Ctrl><U>. From the “User” pull-down list, select a user name.

2. A course outline appears. 
3. Select the section and the quiz score appears in the lower left corner. As the system administrator you can also see 

which sections have not been viewed by looking for the starred icons.
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Any quiz that has not been taken displays the message “0 out of…”.
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4.0 VIEWING KEYNOTES 
KeyNotes are supplemental text documents that enhance your CD-ROM training. KeyNotes are generally stand-alone training 
materials that cover the important concepts and features contained in the CD training. The “KeyNotes” feature lets you select a 
particular topic and then view a text document, complete with graphics. Note that not all training have KeyNotes.

To view a KeyNote…

1. Select the topic and click on the “KeyNotes” button, or select “View KeyNotes” from the “Action” menu, or press 
<Ctrl><S> on your keyboard.

2. The following “KeyNotes” dialog box appears. The KeyNote file you selected from the course outline appears 
highlighted. Click  “Select” to continue. 

3. The KeyNote Viewer appears. In the text window, below the menu and button bar, you see the text for the topic you 
selected.
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The bar to the right lets you scroll up and down through the entire KeyNote file.
The “File” menu allows you to print the KeyNote and close the KeyNote Viewer. 

The “Edit” menu allows you to select all the text in the document and copy the selected text to the clipboard. 

The buttons below the menu bar let you close the viewer, select all the text in the document, copy selected text to the 
clipboard, or print the KeyNote. These features are also found in the “File” and “Edit” menus.

You can change the window size by moving the cursor to any edge and when the cursor changes to a double-headed arrow 
click and drag to desired size.

To move the KeyNote’s viewer, simply click and drag on the title bar to the new location.
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5.0 KEYWORD SEARCHING
The keyword searching feature allows you to enter a few characters of a topic and then immediately view a video or text lesson 
file. This feature is accessed from the “Help menu.

1. Select “Keyword Search”.

2. The “Keyword Search” box appears.

3. Within the “Find” tab, enter the first few characters of the topic you wish to search on.

4. Below the enter line, the closest match is highlighted. With this topic highlighted, click on “Next”.
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5. The “Select” tab becomes active. The “Previous” button takes you back to the “Find” tab to alter your search. To view 
the lesson file for this topic, click “Display”. If more than one lesson file is assigned to the topic, select the file you wish 
to view and click “Display”.

Lesson files with the format, “Demo” are ScreenCam (“.scm”) files. Files with the format “Video” are Mpegs (“.mpg”).  
The “Text” files are the KeyNotes that are also accessed with the “KeyNotes” button or from the “Action” menu.

Depending upon the format or type of lesson file, you see a KeyNotes Viewer (A), a Microsoft ActiveMovie Player 
window (B), or the Lotus ScreenCam Player (C). 
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6.0 SYSTEM ADMINISTRATION

6.1 Setting Up the Training For Multiple Users
For those sites that have multiple users accessing the training, the system administrator needs to setup each individual user with a 
login and password. As the administrator you need to perform this for yourself as well. This section shows you how to setup your 
KeyStone Multimedia Training to accept multiple users and how to create login names and user passwords.

To enable the multiple user feature, do the following:

1. Start your KeyStone Training application. From the “Administration”menu, select “Multiple Users”. 

2. With this feature checked, every user will be required to login with a name and a password everytime the training is 
opened, including the administrator. You are now ready to start adding the users to the application.

6.2 Adding Users
Adding users is done with the “Maintain Users” feature. To access this feature select “Maintain Users” from the 
“Administration” menu. “Maintain Users” lets the administrator add and delete user logins and passwords and reset the user 
history for the system. Only the administrator will be able to use the “Maintain Users” and “Multiple Users” options on this 
menu, so don’t forget to add a password for yourself, otherwise your users may be able to login as you. Let’s first add a login and 
password for the administrator:

1. The Last Name and First Name for the administrator is set to “User” and “Default”. These two names cannot be changed. 

The administrator’s login defaults to “Administrator” but you can change this to whatever login you prefer. 
2. Next, enter the password in the “Login Password” field. 
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3. After you enter the password you are asked to verify the password. Re-enter the password.

Below the “Verify Password” field is the “Security” Radio buttons. There are two settings found here, “Administrator” 
and “Student”. Since there can only be one administrator, each new user is given the security level of  “Student”. These 
radio buttons function only to display the security level for each user and do not give you the ability to change that level. 

Now click “Save”. 

4. To enter your users click on “New”.

5. Enter the user’s last and first name, login name, and password. 

6. Re-enter the password to verify, and click “Save”. You will have to do this for every user who accesses this training.

If you forget to enter a password for the administrator, the next time the program is launched just login as “Administrator” 
and click “OK”. The program opens without you entering a password. It is suggested that you assign a password to the 
administrator after you have completed the installation to prevent any unauthorized access by users.

Only the Administrator will be able to see all users’ progress and quiz results. Individual users can only see their own 
progress and scores. If this is for a single user, simply leave “Multiple Users” unchecked and you will not need to enter
a login or password. The program still keeps track of your progress and scores regardless if the “Multiple Users” feature is 
checked or unchecked.
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6.3 Deleting Users
Deleting users is also done with “Maintain Users” feature. 

1. To the left of the entry fields is a list of users. From this list select the user you wish to delete. 

2. Click on the “Delete” button.

3. A “Verify Delete” warning box appears. Click “Yes” to confirm the deletion or “No” to cancel the deletion.

6.4 Resetting User Quiz Scores
There may be times when your students will need to retake quizzes. A nice feature found on the “Maintain Users” dialog box 
that lets you start off each user with a clean slate is called “Reset User History”. 

1. From the users list, select a user.
2. Located below the user list is a button labeled “Reset User History”. Click on this button.

3. You are asked to verify this reset. Click “Yes” to continue or click “No” to cancel.
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6.5 Un-installing the Program
If for any reason you need to uninstall your Multimedia program, do the following steps:

1. Close the program
2. Click on “Start”, highlight “Settings”, and select “Control Panel”.

3. Double click on the “Add/Remove Programs” icon. 

4. Click the “Install/Uninstall” tab on the “Add/Remove Programs Properties” dialog box.

5. Highlight the program to remove.
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6. Click “Add/Remove…”.

7. Click “Yes” in the “Confirm File Deletion” dialog box and your computer removes the program along with all other files 
that were loaded with the program.

The “Remove Programs…” dialog box appears showing the status of the uninstall. Click “OK” when the message 
“Unistall successfully completed” appears.
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